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Preface

Wabi™ software enables you to run Microsoft Windows and other applications
that run on Microsoft Windows on a UNIX workstation. WabiServer™ software
enables you to run Wabi software on a server and access it from several client
systems at the same time. The WabiServer Administrator’s Guide tells a system
administrator how to plan, install, and maintain WabiServer software on a
network of server and client systems.

Information on using Wabi can be found in the Wabi User’s Guide. For this Beta
release, information on the differences between using Wabi and using
WabiServer can be found in the WabiServer 1.0 Read This First.

Who Should Use this Book
Read this book if you are going to plan, install, or maintain a WabiServer
system with client systems running Wabi remotely.

Before You Read this Book
This book attempts to provide all the information you will need to plan, install,
and maintain a WabiServer software on server and client systems. While the
book tries to be complete, in some cases, it must assume some knowledge of:

• Solaris™ system administration
• Microsoft Windows environment
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In the Solaris environment, tasks you will perform include: planning file server
resources, checking system space, obtaining more system space on a file server,
making paths accessible by all systems on the network, using a text editor,
creating a user, and making directories.

In the Windows environment, tasks you must perform include: sizing and
moving Windows, making drive connections, running commands, and
installing applications.

For information on Solaris system administration, see the Solaris System
Administrator Answerbook and Solaris User Answerbook.

For information on the Microsoft Windows environment, see the Microsoft
Windows User’s Guide that comes with your copy of Microsoft Windows and
Microsoft Windows license agreement.

How This Book Is Organized
Chapters in this book are described briefly below.

Chapter 1, “Introduction to WabiServer,” briefly describes Wabi and introduces
WabiServer.

Chapter 2, “Planning WabiServer Configuration,” gives you procedures for
planning your site’s configuration. It includes system requirements for servers
and clients.

Chapter 3, “Installing WabiServer on Servers,” describes how to install
WabiServer software on a server.

Chapter 4, “Creating Prototypes,” describes how to create prototypes which
are used to create users’ personal Wabi directories. These directories create
access to Windows and other Windows applications.

Chapter 5, “Installing WabiServer Client Software on Clients,” describes how
to obtain access to WabiServer client software from a client system and how to
run Wabi remotely, selecting a WabiServer and a set of applications to run.

Chapter 6, “Administrator Tools,” describes the tools for creating prototypes
and allowing or disallowing diskette drive and printer access.

Chapter 7, “Troubleshooting,” describes solutions to selected problems.
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Appendix A, “WabiServer Files and Directories,” contains a table that describes
the contents of selected WabiServer files and directories.

Procedures Are Marked with ▼

If you look in the Table of Contents in the front of this book you will see some
sections marked with and upside-down triangle, ▼, like this:

▼ To Remove an Existing Wabi Package

These sections contain procedures presented succinctly. Explanatory material
relevant to the procedure is presented before the procedure. If you do not need
an explanation, you can perform the procedure by following the procedure’s
steps. If you need an explanation, read the material before or after the
procedure.

Single Steps Are Marked with ♦

If there is more than a single step in a procedure, the steps are numbered. A
solitary step in a procedure is marked with a diamond, ♦, like this:

  ♦ Log in as root.

Related Books
This is book is intended to be used with:

• WabiServer 1.0 Read This First
• Wabi User’s Guide
• Wabi 2.1 Release Notes

You will also need the following books:

• Windows application documentation: installation, administration, and user
guides

You may also want to consult the following books:

• Solaris System Administrator Answerbook
• Solaris User Answerbook.
• Microsoft Windows User’s Guide
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What Typographic Changes Mean
The following table describes the typographic changes and some symbols used
in this book.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.

➤ Cascading menu picks are
designated by arrows.

“Select File ➤ Run” means to select
the Run item from the File menu.

▼ Marks a procedure. ▼ To mount the CD-ROM

♦ Marks a step that is the sole
step in a procedure.

♦Log in as root.
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Shell Prompts in Command Examples
The following table shows the symbols used in this book to indicate the user
prompt and the superuser prompts. These prompts are included with
command examples to remind you of whether you need to be logged in as a
regular user or as the superuser when you enter the command.

Note – Do not enter these symbols with the command.

Windows Environment Typographic Conventions
The following table shows some typographic conventions used in the Windows
environment.

Table P-2 User Prompts

User Logged In Prompt

C shell prompt for a regular user %

Superuser prompt #

Table P-3 Windows Environment Typographic Conventions

Convention Example

File names are separated by backslashes. \files\protos

A drive is a letter followed by a colon. C:

A drive can be mapped to a directory
path, similar to a link. For example, the C
drive is mapped to your Wabi directory.

C:  is equivalent to ~/wabi .
C:\letters  is equivalent to the
~/wabi/letters  directory.
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Introduction to WabiServer 1

WabiServer gives multiple users simultaneous access to the complete
functionality of Wabi. This allows them to use productivity applications
designed to run on Microsoft Windows on a UNIX workstation.

This chapter introduces WabiServer by defining and contrasting Wabi
capabilities and WabiServer capabilities. It compares the two products by
highlighting important concepts of system configuration for both. It describes a
simple WabiServer configuration. It introduces the use of prototypes, which
contain installed applications and are used to create users’ personal Wabi
directories.

What Is Wabi?
The Wabi program is a UNIX application that enables you to run Microsoft
Windows applications on several UNIX operating environments that use the X
Window System. Wabi acts as an interface between the Windows applications
and the UNIX operating system, translating Microsoft Windows system calls
into UNIX system calls.

The Wabi program enables you to retain the security, power, and network
capabilities of your UNIX operating system, while, on the same desktop, lets
you access to Microsoft Windows applications such as spreadsheets, word
processors, databases, and graphics packages. The most popular Windows
applications have been tested extensively in the Wabi environment. (See
Table 1-1 on page 26 for the list of applications that have been certified
compatible with the Wabi program.)
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1

The original Wabi product is primarily designed for a single user.   Generally,
users of standalone Wabi are responsible for installing Microsoft Windows and
Windows applications on their own disks. This book refers to the original Wabi
product as standalone Wabi.

For more introductory information on Wabi, such as functional capabilities, see
Chapter 1, “What is Wabi?”, in the Wabi User’s Guide.

This section shows the important concepts of two standalone Wabi
configurations: standalone Wabi on a local system, and standalone Wabi on a
remote system.

Standalone Wabi on a Local System

Figure 1-1 shows a standalone Wabi configuration. You can run standalone
Wabi only on higher-end workstations.

Figure 1-1 shows that

• Wabi software resides on the local disk and runs on the local system.

• The Wabi display is on the local system.

Figure 1-1 Standalone Wabi On a Local System

Sun Workstation

O p t i o n s Q u i t

WABI
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1

Running Wabi on a Remote System

Like all X Windows applications, you can run Wabi from a remote system and
display it on the local system. This configuration allows you to use Wabi on
lower-end workstations and X terminals. In this configuration, you cannot use
the diskette drives or printers on the local system.

Figure 1-2 shows standalone Wabi accessed remotely.

• Wabi software runs on a remote system. (Figure 1-2 shows the remote
system as a server.)

• The Wabi display is on the local system

Figure 1-2 Standalone Wabi Accessed Remotely
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What is WabiServer?
The WabiServer product enables multiple users to access a single installation of
Wabi software on a server. WabiServer frees users from the administrative
tasks of installing Wabi, Microsoft Windows, and Windows applications, while
enabling system administrators to perform tasks once to provide Wabi to many
users. The system administrator installs Wabi and WabiServer software,
chooses printer and diskette drive options, and installs Microsoft Windows and
Windows applications. Once the WabiServer client software is set up on a
user's machine, a user simply starts the remote Wabi program and can begin
using the applications made available by the administrator.

A server is defined for this book as a system that runs Wabi and WabiServer
software. It allows users to access this software from remote systems. The
remote system is a client.

Benefits of WabiServer

WabiServer provides:

• Performance through shared resources: Allows multiple users simultaneous
access to Wabi on a server, taking best advantage of available resources.

• Access from SPARCstation to Windows applications running on a native
processor (Pentium) server: If you select a powerful server as the
WabiServer platform, you can supply high performance for Windows
applications to many Solaris 1.x (SunOS™) and low-end workstations.

• Centralized management and control of Microsoft Windows applications: By
installing WabiServer at your site, you are freeing your users from having to
install applications, while providing them with flexible and efficient access
to shared applications.

• Wabi access by client systems running low-end client systems: The
standalone Wabi program is not supported for Solaris 1.x systems and may
not run on low-end systems. WabiServer does provide access to Wabi for
Solaris 1.x (SunOS) and low-end systems, such as X terminals.

• Access to local printers and local diskette drives: System administrators can
give users access to local diskette drives, the server’s diskette drives, or no
diskette drives. The administrator can give users access to printers
configured on their local systems, printers configured on the server, or both
sets of printers.
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Minimum WabiServer Configuration

Figure 1-3 shows a minimum WabiServer configuration. Here, you have access
to your local diskette drives and local printers. Several clients can access the
WabiServer simultaneously.

• Wabi and WabiServer software run on the server system.

• The Wabi display is on the local system.

• Typically users’ home directories are located on a remote file server.

• The first time you run Wabi remotely on the client (using the rwabi
command), you must install Microsoft Windows from diskettes into your
Wabi directory.

This minimum configuration does not take advantage of one of WabiServer’s
main features—its use of prototypes to install Windows applications for users.

Figure 1-3 Minimum WabiServer Configuration
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WabiServer Terminology

In addition to speed and efficient use of resources, WabiServer also provides
you with a way to easily set up users to access the applications they need. It
does this using a concept called prototypes. This section introduces the terms
Wabi directory, prototypes, and shared applications and describes their use in the
WabiServer environment.

Wabi Directory. A user needs a Wabi directory in order to run Wabi. A user’s
Wabi directory contains Microsoft Windows software, other Windows
information, Wabi information, and may contain other applications.

Prototypes. A prototype is a compressed image of a Wabi directory that is used
to create a user’s Wabi directory.

A prototype can contain Microsoft Windows and any number of other
applications that run on Windows. For instance, a prototype could contain
Microsoft Windows, a complete application, and the client portion of a shared
application. The simplest prototype contains only Microsoft Windows.

You can create several prototypes that contain different sets of applications.
You are limited only by the amount of disk space you have available.

WabiServer software contains a tool that you can use to create prototypes for
your users, the ws_bldproto  tool.

Shared Applications. Most suites of applications, like Microsoft Office and Lotus
SmartSuite, give you the option of installing the application suite in a shared,
network installation configuration. In such a configuration, the shared portion
of the application resides on a server and a small portion resides on the client.
Several clients can share the application over the network. This saves disk
space and maximizes resources.

Chapter 4, “Creating Prototypes,” includes directions for installing Lotus
SmartSuite and Microsoft Office as shared applications and creating the client
portions of these applications in prototypes.

Both shared applications and prototypes can reside wherever you have space
on the network, either on the WabiServer or on a file server. Performance is
better with shared applications if the shared software resides on the user’s
current WabiServer.
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WabiServer with Prototypes Configuration

Figure 1-4 shows a WabiServer with prototypes and shared applications.

• Wabi and WabiServer software are on the WabiServer disk.

• The Wabi display is on the local system.

• Typically users’ home directories are located on a remote file server.

• Shared applications and prototypes are on the current WabiServer.

• The first time you run Wabi remotely on a client system, you are asked for
the name of a Wabiserver, a Wabi directory location, and a prototype.

Figure 1-4 WabiServer with Multiple Prototypes
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Certified Compatible Applications
Table 1-1 lists applications that have been tested and certified compatible with
WabiServer 1.0 and Wabi 2.1.

Table 1-1 Applications Certified for the Wabi Program

Certified Application Name Supported Versions

Aldus PageMaker 4.0, 5.0

CorelDRAW! 3.0, 4.0

Harvard Graphics for Windows 2.0, 3.0

Intuit Quicken 3.0, 4.0

Lotus1-2-3 for Windows 4.0, 5.0

Lotus Ami Pro 3.01, 3.1

Lotus Approach 2.1, 3.02

Lotus cc:Mail (Client only) 2.0, 2.03

Lotus Freelance Graphics 2.01, 2.1

Lotus Notes (Client only) 3.0, 3.3

Lotus Organizer 1.1, 2.01

Lotus SmartSuite 2.0, 3.1

Microsoft Access 2.0

Microsoft Excel 4.0, 5.0

Microsoft Mail (Client only) 3.2

Microsoft Office 4.3

Microsoft PowerPoint 3.0, 4.0

Microsoft Project 3.0, 4.0

Microsoft Word for Windows 2.0, 6.0

Paradox for Windows 4.5, 5.0

PROCOMM PLUS for Windows 1.0. 1.02

Quattro Pro for Windows 5.0, 6.0

WordPerfect for Windows 6.0a, 6.1
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Note – Applications other than those listed may work with the Wabi program if
they conform to Microsoft Windows 3.1 application program interface
conventions. Lack of inclusion in this list means that an application has not
been tested for compatibility with the Wabi program.
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Planning WabiServer
Configuration 2

This chapter contains information on planning a WabiServer configuration
consisting of servers, clients, users, and software.

The section “System Requirements” on page 32 lists hardware and software
that is supported for server systems and client systems.

How to Plan Your WabiServer Configuration
The following list of tasks gives you some guidelines to use in planning a
WabiServer installation. It describes some of the factors you will be balancing,
such as the number of applications on a server, the number of users accessing
those servers, which applications you will supply in prototypes, and which
applications users will load themselves.

1. Poll your users to determine their Windows application needs.
See the list of applications certified to run on WabiServer 1.0 in Table 1-1 on
page 26.

2. Identify users as either power users or casual users.
Power users use Microsoft Windows applications fairly continuously all
throughout the day. Casual users use applications sporadically during the
day. You might want to mix power users and casual users on a single server.
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3. Determine how many WabiServers you will need to accommodate the
number of users you have.
Power users are much more demanding of system resources than casual
users. For example, one power user may require as much processing time as
three to five casual users. Therefore, depending on system configuration,
you can accommodate more than 10 power users or more than 30 causal
users.

4. Choose which applications you will make available to your users and
which ones you will let them install themselves.
You want to provide prototypes for applications that are needed by several
users, but have individual users install applications that are needed by only
one or two users (or you can provide this service for them). Adding
additional applications to a prototype increases the disk space of all users of
that prototype.

For example, if only two users want to use Corel Draw, you might let these
users install Corel Draw themselves, rather than putting Corel Draw into a
prototype. On the other hand, if you put it into a prototype, then it will be
available to any licensed user who wants to access it.

5. Determine which of these applications you can install as shared
applications.
Microsoft Office, Lotus SmartSuite, and the component packages of these
suites, can be installed as shared applications. Consult your specific
application’s documentation to see if it can be installed as a shared
application. See “WabiServer Terminology” on page 24.

6. Choose which applications you want to group into prototypes.
You will group applications where users’ needs overlap.

For example, eight people want Microsoft Office and six people want Lotus
SmartSuite. Of these 14 people, eight of them, some from each group, want
to use Quicken.

One way you could accommodate these users is to create two prototypes:
one prototype that contains Microsoft Office and Quicken and another that
contains Lotus SmartSuite and Quicken.

Another way you could accommodate these users is as follows: Both
Microsoft Office and Lotus SmartSuite can be installed as shared
applications. As shared applications, the client portions of these suites are
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small. Quicken is also a fairly small application.   You could make a single
prototype to accommodate all 14 people that includes all three applications,
Microsoft Office, Lotus SmartSuite, and Quicken.

7. Choose systems to be WabiServers.
See the section “Server System Requirements” on page 32.

8. Identify users and client systems.
See the section “Client System Requirements” on page 33.

9. Choose WabiServer locations where you have enough disk space for your
prototypes and shared applications.
See your application documentation for disk space needed for each
application you plan to install. Prototypes are compressed after creation, so
the prototypes use less space than the uncompressed applications need.

The shared software portion of shared applications is accessed often by
users. You will get the best performance if this shared portion resides on the
current WabiServer and not on a remote server.

Prototypes will create Wabi directories faster if they reside on the
WabiServer, but as prototypes are not accessed as often as the shared
portion of shared applications, their placement on the current WabiServer is
not critical.

10. Check that each user’s home directory has enough space to hold the
uncompressed prototype it needs.
The users’ Wabi directories must have enough space to hold the applications
they need to run. When you build a prototype, its uncompressed size is
added to its description for you and appears in the prototype list. (See
Figure 5-2 on page 90 for an example of a prototype list showing Wabi
directory sizes.)

11. Check that the users’ Wabi directories are network-aware; specifically they
must be NFS-accessible by the server.
Typically users’ Wabi directories are in their home directories. The home
directories must be on file systems that are shared by the network.

12. Order a Microsoft Windows license for each user who will be using Wabi.
Order licenses for users for all other applications they will be using.
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Note – As system administrator, you are responsible for ensuring that no
copyrights are violated and that all users have licenses for the applications
they run, as applicable under Federal copyright law.

System Requirements
This section describes hardware and software supported by WabiServer,
presented separately for a server system and a client system.

Server System Requirements

Systems that can be WabiServers must consist of the following:

Computers

• All SPARCserver™ models, SPARCcenter™ 2000, and SPARCcluster™ 1
• Pentium-based computers

Operating System

• Solaris 2.5, 2.4

Display

• 1-bit, 4-bit, 8-bit, or 24-bit pixel-depth displays.
• 24-bit displays are supported using 8-bit pseudo color, not TrueColor.

Recommended Memory

• 48 Mbyte on SPARC plus 8 Mbyte for each user
• 32 Mbyte on a Pentium plus 8 Mbyte for each user

Swap Space

Run the UNIX swap -s  command to see your total and available swap space.

• On an Pentium: 20 Mbyte of swap space per user if you are running Wabi
and a single application only; 10 Mbyte of swap space for each additional
application

• On a SPARC: 30 Mbyte of swap space per user if you are running Wabi and
a single application only; 10 Mbyte of swap space for each additional
application
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Disk Space

• Standalone Wabi, SUNWwabi— 7 Mbyte
• WabiServer, SUNWwsvr — 7 Mbyte
• WabiServer Client, SUNWwclt — 6 Mbyte
• Wabi User’s Guide, SUNWaws — 3.5 Mbyte
• WabiServer Administrator’s Guide, SUNWawr — 2.5 Mbyte

Network Access

• Access to users’ home directories (can be local, but a shared location on a
file server is typical)

• Access to prototypes
• Access to shared applications (local storage is recommended)

Client System Requirements

Systems that can be clients of a WabiServer must consist of the following:

Computers

• All SPARC-based models
• Pentium-based computers
• X Terminals

Operating System

• Solaris 2.5, 2.4, 2.3
• Solaris 1.x (SunOS 4.1.3, 4.1.4)

Memory

• The amount needed by the operating system (no additional memory
required)

Swap Space

• The amount needed by the operating system (no additional swap required)

Display

• 1-bit, 4-bit, 8-bit, or 24-bit pixel-depth displays.
• 24-bit displays are supported using 8-bit pseudo color, not TrueColor.
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Network Access

• Access to users’ home directories (can be local, but shared access to a file
server is typical)

• Access to the WabiServer program (either shared from the server or the
WabiServer client package installed on the client)

Installed Software
The following list shows what software is installed on the server and the client.

On the server:

Wabi 2.1 Revision B
WabiServer server software
WabiServer client software (optional, on either the server or the client)
Wabi User’s Guide Answerbook
WabiServer Administrator’s Guide Answerbook
Solaris Patches

On the client:

WabiServer client software (optional, on either the server or the client)
Wabi User’s Guide Answerbook
Solaris Patches

Installation Process Summary
Chapters 3-5 describe the procedures to follow for installing WabiServer
software on servers, creating prototypes, and installing WabiServer client
software on clients. The following is a summary of the steps you will perform
to accomplish these tasks.

Installing the Server

1. Remove existing Wabi patches, AnswerBook packages, Wabi packages, and
WabiServer packages, as necessary.

2. Install any needed Solaris patches.

3. Install AnswerBook packages, Wabi software, WabiServer client software,
and WabiServer software, as needed.
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Creating Prototypes

1. Create a Windows only prototype.

2. Create other prototypes, as desired.

Installing the Client

1. Remove existing Wabi patches, Wabi packages, and WabiServer client
packages, as necessary.

2. Install any needed Solaris patches.

3. Install the WabiServer client software (or you can access the WabiServer
client software on the server).

4. Disable Volume Manager.

Running Wabi Remotely On a Client for the First Time

1. Enter the path to the rwabi  command in the user’s .cshrc  file.

2. Run rwabi .

3. Select a WabiServer on which to run Wabi remotely.

4. Select the name of a Wabi directory.
If your Wabi directory does not exist, you are asked for the name of a
prototype from which to create a Wabi directory.
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Installing WabiServer on Servers 3

Chapters 3-5 describe the procedures to follow for installing WabiServer
software on servers, creating prototypes, and installing the WabiServer client
software on clients. These procedures are summarized at the end of Chapter 2,
in the section “Installation Process Summary” on page 34.

The command lines in the procedures in this chapter use different system
prompts to indicate whether you must be logged in as root or a regular user.
The prompts chosen are used typically in UNIX to indicate a root  login or a
regular user csh  (C-Shell) login.

# — logged in as root

% — logged in as a regular user in the C-Shell, usually wsadmin

Do not enter these characters when you are entering the command line.

Preparing for Server Installation
Perform the following steps before beginning the installation.

1. Read Chapters 1 and 2 and plan your initial configuration of servers,
clients, and applications.

2. Check that the server and clients have their operating systems completely
installed.
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3. Check the WabiServer 1.0 Read This First (the release notes) for any last
minute installation information. Keep the release notes available; you
will need them for patch information.

4. Collect the following items:
• WabiServer 1.0 CD-ROM
• CD-ROM caddy (if required for your system)
• Your CD-ROM target number (needed only if you do use Volume

Manager)

5. To create prototypes and install clients, collect the following items:
• WabiServer 1.0 Client CD-ROM
• Windows software (diskettes or CD-ROM)
• Windows applications software (diskettes or CD-ROMs)
• Windows applications installation documentation

Starting Server Installation
This chapter describes the steps you need to perform on the server. In this
chapter, you will:

1. Remove existing Wabi patches, Wabi packages, WabiServer packages, and
AnswerBook packages, as necessary.

2. Install any needed Solaris patches.

3. Install Wabi software, WabiServer software, WabiServer client software, and
AnswerBook packages, as needed.

Determine which bullet below applies to your site and go the section specified.

• If you are not currently running Wabi or WabiServer on the server you have
chosen for the installation, skip to the section “Server Installation” on
page 43.

• If you are running a version of Wabi or WabiServer, go to the next section
"Remove Existing Packages."
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Remove Existing Packages
The WabiServer CD-ROM contains the Wabi 2.1 Rev B software package. Find
all the bulleted items in the list below that apply to your installation and
perform the following procedures, as appropriate.

• If you are running Wabi 2.1 or an earlier version, you will remove any Wabi
patches, then remove Wabi, and then install Wabi 2.1 Rev B.

• If you are running WabiServer and need to upgrade to this newer version,
you will remove WabiServer and WabiServer Client and then install the new
versions.

• If you have installed Wabi 2.1 AnswerBook, you will be upgrading to Wabi
User’s Guide, which includes WabiServer user information You will remove
the existing Wabi AnswerBook before installing a newer version.

▼ To Remove an Existing Wabi Package

1. Check for installed Wabi patches by entering the following commands.

% showrev -p | grep SUNWwabi
any output such as:
Patch: 102330-02 Obsoletes: Packages: SUNWwabi 2.0,PAT

2. Become superuser.

% su

3. Choose the bullet below that applies to you and follow the instructions:
• If you have no Wabi patches installed, go to Step 4.
• If you have Wabi patches installed, enter the following command for each

patch, replacing patch-id with the patch number.

# /var/sadm/patch/ patch-id /backoutpatch patch-id

4. Enter the following command to remove the Wabi package.

# pkgrm SUNWwabi
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When you press Return, the pkgrm  program displays a message similar to
the following:

5. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

6. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

▼ To Remove Existing WabiServer and Client Packages

1. Become superuser if you are not already.

2. Enter the following command to remove the WabiServer package.

# pkgrm SUNWwsvr

When you press Return, the pkgrm  program displays a message similar to
the following:

The following package is currently installed:

SUNWwabi   Wabi Application

Do you want to remove this package [y,n,?,q]

Removal of <SUNWwabi> was successful.

The following package is currently installed:

SUNWwsvr   WabiServer Application

Do you want to remove this package [y,n,?,q]
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3. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

4. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

5. Enter the following command to remove the WabiServer client package.

# pkgrm SUNWwclt

When you press Return, the pkgrm  program displays a message similar to
the following:

6. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

7. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

Removal of <SUNWwsvr> was successful.

The following package is currently installed:

SUNWwclt   WabiServer Client Application

Do you want to remove this package [y,n,?,q]

Removal of <SUNWwclt> was successful.
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If you want to remove an existing Wabi AnswerBook, go to the next section. If
you do not want to remove Wabi AnswerBook, go to “Server Installation” on
page 43.

▼ To Remove an Existing Wabi AnswerBook

1. Become superuser if you are not already.

2. Enter the following command to remove the Wabi AnswerBook:

# pkgrm SUNWaws

When you press Return, the pkgrm  program displays a message similar to
the following:

3. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

4. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi AnswerBook package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

The following package is currently installed:

SUNWaws Wabi x.x AnswerBook

Do you want to remove this package [y,n,?,q]

Removal of <SUNWaws> was successful.



Installing WabiServer on Servers 43

3

Server Installation
This section gives procedures for installing WabiServer software on a server.
Start here if this is the first time you are installing WabiServer software on this
system or if you have completed the steps in the previous section “Remove
Existing Packages” on page 39.

Install Solaris Patches from the WabiServer CD-ROM

The WabiServer 1.0 Read This First contains information about Solaris patches
you may need to install before using the Wabi program. The patches are
included on the WabiServer CD-ROM. If you were running Wabi previously,
you may already have installed versions of the patches that are sufficient to fix
any potential Wabi problems.

♦ Follow the instructions in the WabiServer 1.0 Read This First to see if you
need to install any patches.

Install WabiServer Packages

To install WabiServer packages, you will mount the CD-ROM and run the
pkgadd command.

▼ To Mount the WabiServer CD-ROM

1. If you do not know whether or not you are using Volume Manager, enter
this command:

# ps -ef | grep vold

If the process /usr/sbin/vold  is reported, you are using Volume
Manager. If this command gives you no output, you are not using Volume
Manager.

2. If you are using the Solaris Volume Manager, insert the WabiServer
CD-ROM into the CD-ROM drive.
The CD-ROM file system is mounted automatically. Go to the section “Run
pkgadd” on page 44.
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3. If you are not using the Solaris Volume Manager, create a mount point
before inserting the CD-ROM into the CD-ROM drive and then mount
the CD-ROM.

a. If you do not already have one, as superuser, create a directory for the
CD-ROM by entering:

# mkdir /cdrom

b. Insert the Wabi CD-ROM into the CD-ROM drive.

c. Mount the CD-ROM with one of the following commands, depending
on which version of Solaris you have:

SPARC# mount -o ro -F hsfs /dev/dsk/c0t6d0s2 /cdrom

x86:# mount -o ro -F hsfs /dev/dsk/c0t6d0p0 /cdrom

Note – The c0t6d0s2  and c0t6d0p0  device numbers used in these
commands assume your CD-ROM drive is set to SCSI target number 6. If you
get the response “no such device,” your CD-ROM probably uses a different
SCSI target number. If target number 6 did not work, on a Solaris system, you
can enter the ls -l /dev/sr0  to find your target number.

Run pkgadd

Use the pkgadd  command to copy the WabiServer packages to your system.

Note – Do not use either of the Software Manager programs, swm or swmtool ,
to install Wabi software. These tools expect a CD-ROM file system layout that
is different from the one used on the WabiServer CD-ROM.

This pkgadd  procedure also installs the Wabi User’s Guide AnswerBook and the
WabiServer Administrator’s Guide AnswerBook, Wabi and WabiServer on-line
documentation. To read these, you must have AnswerBook software installed
on your system. If AnswerBook software is not installed, see Solaris
documentation for installation instructions.
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▼ To Run pkgadd

1. Enter the command below according to whether you are using Volume
Manager or not:

If you are using Volume Manager, enter:

SPARC# pkgadd -d /cdrom/wabiserver_1_0/sparc

x86:# pkgadd -d /cdrom/wabiserver_1_0/i86

If you are not using Volume Manager, enter:

SPARC# pkgadd -d /cdrom/sparc

x86:# pkgadd -d /cdrom/i86

When you press Return, the pkgadd  program displays a screen similar to
the following (with some additional detail):

2. Select the packages you need to install. To run WabiServer, your server
must have both the Wabi and the WabiServer applications installed.
Either

• Press Return to select all five packages.
• Enter selected numbers separated by spaces or commas.

The pkadd  program begins the installation process.

The following packages are available:

1 SUNWawr WabiServer Administrator’s Guide
(all)

2 SUNWaws Wabi User’s Guide
(all)

3 SUNWwabi Wabi Application
(machine) 2.1 B

4 SUNWwclt WabiServer Client-side Application
(i86,sun4-Solaris,sun4-SunOS) 1.0

5 SUNWwsvr WabiServer 1.0 Application
(i86,sun4-Solaris) 1.0

Select package(s) you wish to process (or “all” to process
all packages). (default all) [?,??,q]:
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If you selected one or both AnswerBooks, the pkgadd  program displays the
following prompt.  If you are installing both AnswerBooks, the WabiServer
Administrator’s Guide is installed first. Both AnswerBooks are displayed with
idential dialog boxes.

3. Enter an installation option for the AnswerBook.
If you enter 1, the nil  option, most of the AnswerBook files will remain on
the CD-ROM. With this option, you must place the CD-ROM in the drive to
use the AnswerBook. This option saves disk space, but increases access time
to the AnswerBook files.

If you enter 2, the heavy  option, all the AnswerBook files will be installed
on your disk. This option requires more disk space, but does not require the
CD-ROM to view the AnswerBook. It is also provides faster performance.

After you enter an installation option, the pkgadd  program prompts you for
the parent directory for the AnswerBook.

4. Enter the name of the directory where you want to install the
AnswerBook package.
If you chose the nil  option, specify a parent directory on a file system with
at least 1 Mbyte of free space. If you chose the heavy  option, specify a
parent directory on a file system with the amount of free space required.

The installation options are as follows:
Option: Description:
--------------------------------------------
1. nil: less than 1 Megabyte disk space required [slowest performance].
2. heavy: x.x Megabytes disk space required [best performance].

Note: If the install option which you choose below fails
due to lack of space, try another location, or
choose a lower install option number.

Enter the number of an installation option from the list above (1 or 2).

Select an installation option:
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The pkgadd  program then prompts:

5. Enter y  to proceed with the installation.
File names and system messages are displayed as the package is transferred
to your system from the CD-ROM.

When installation is complete, pkgadd  displays the following:

6. If you selected both AnswerBooks, the Wabi User’s Guide is installed with
identical dialog boxes to those in Steps 2-5.
When the AnswerBooks that you selected have been installed, pkgadd
install the other packages.

7. If you are installing the Wabi package and running Solaris 2.4 with
Volume Manager’s control of the diskette drive enabled, pkgadd displays
the following prompt:

This package contains scripts which will be executed with
super-user permission during the process of installing this
package.

Do you want to continue with the installation of this package
[y,n,?]

Installation of <SUNWawr> was successful.

To use your diskette drive under Wabi, we recommend that you
disable Volume Manager's control of the diskette drive.

Would you like this done now?
Yes or No [y,n,?,q]
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This question relates only to your use of the diskette drive on the server. You
do not have to disable Volume Manager’s control of the diskette drive for
your clients to use their local diskette drives.

If you will be using the Wabi program on the server and want to be able to
use the diskette drive, enter y. If you want to use diskettes with Volume
Manager in the Solaris environment, enter n.

If you enter y, the pkgadd  program disables Volume Manager’s control of
the diskette drive. See the Wabi 2.1 Release Notes for information about the
command to use to enable and disable Volume Manager’s control of the
diskette drive at any time.

8. The pkgadd  program prompts:

Enter y  to proceed with the installation.

File names and system messages are displayed at the command line as
software is transferred to your system.

9. If are loading more than a single package, this dialog will be repeated for
each package you are installing.

This package contains scripts which will be executed with
super-user permission during the process of installing
this package.

Do you want to continue with the installation of this
package [y,n,?]
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10. When all the packages that you chose have been installed, the following
message is displayed. Enter q to quit.
You can choose another package at this time if you wish.

Enabling Serial Devices on the Server in Solaris 2.4

When you install the Wabi package, the installation script checks the
permissions of the serial devices. If they are not accessible by all users, the
script suggests that you run the following command as superuser:

chmod 666 /dev/cua/*

If you do not do this, you will not be able to use Wabi COM ports for serial
devices such as modems and local serial printers on the server.

Note – With WabiServer software, you cannot use the COM ports on client
systems for serial devices.

The following packages are available:

1 SUNWawr WabiServer Administrator’s Guide
(all)

2 SUNWaws Wabi User’s Guide
(all)

3 SUNWwabi Wabi Application
(machine) 2.1 B

4 SUNWwclt WabiServer Client-side Application
(i86,sun4-Solaris,sun4-SunOS) 1.0

5 SUNWwsvr WabiServer 1.0 Application
(i86,sun4-Solaris) 1.0

Select package(s) you wish to process (or “all” to process
all packages). (default all) [?,??,q]:
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Restricting Access to Printers and Diskette Drives

By default, users can use the diskette drives on their own client systems. By
default, users can access printers configured on both the client systems and the
WabiServer. To limit access to printers and diskette drives, run the ws_setup
program. See “Setting Access to Printers and Diskette Drives with ws_setup”
on page 93.
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This chapter describes how to create prototypes.

A prototype is a compressed image of a Wabi directory. A prototype contains
Microsoft Windows and may contain other Windows applications. A prototype
is used to create a user’s Wabi directory the first time the user runs Wabi
remotely.

There are four ways you can create a prototype:

• You can create a brand new prototype by installing Microsoft Windows and
then installing additional applications, if desired.

• You can create a prototype by copying an existing prototype and adding one
or more applications to it.

• You can create a prototype from an existing Wabi directory.

• You can establish a prototype on this server by linking it from another
server. After you create a link to the prototype, it is available to your users
as is, or you can create a new prototype by copying and adding to the linked
one.

See Chapter 1, section “WabiServer Terminology” on page 24 for more
information about prototypes.

Be sure you create prototypes in a location that has enough space for all the
applications you plan to install.
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Tutorial Style of this Chapter
This chapter describes procedures for creating four prototypes, one that
contains only Windows, one that contains a complete application, Intuit
Quicken, one that contains Microsoft Office in a network-shared setup, and one
that contains Lotus SmartSuite in a network-shared setup.

This chapter is written using a tutorial style showing a running example. It
tells you to create a wsadmin  user who acts as the WabiServer administrator. It
gives you a specific directory structure to use and names for your prototypes.
It uses specific names for the servers.

You can choose other names or other directory structures if you want, but, if
you do, you must substitute the names you are using into the correct positions
in the following procedures. In any case, you will have to substitute the names
of the servers you are using for the ones used in our example.

Create a wsadmin User and a Prototype Directory
We suggest that you create a user named wsadmin . There are a few reasons for
creating a wsadmin  user:

• You can tell by the wsadmin  ownership which directories are part of your
WabiServer installation.

• Some Windows applications, especially shared ones, need to be installed by
a regular user rather than root . User wsadmin  serves this function.

• Creating an administrative account makes it less likely that files and
prototypes are accidentally changed.

To create a wsadmin  user, you can use the admintool  or the useradd
command to create the user, depending on the custom at your site. If you are
using yp , use the admintool  to add this user to your yp  database.

Here is an example of a useradd  command. If you want to use this command,
execute it as superuser on the file server where your home directories reside.

# useradd -c "WabiServer Admin" -m -d /files1/wsadmin \
-s /bin/csh wsadmin

The -m option creates the home directory as /files1/wsadmin .
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In the example in this chapter, /files1  is an exported (or shared) file system
on the file server universe . In the /etc/dfs/dfstab  file on universe ,
there is the following entry: share -F rw=domain /files1 .

When activated, the Automounter reads the dfstab  file on universe  and
makes the shared files accessible to other systems on the network using the
pathname prefix of /net/ servername . In our example, /files1  on
universe  is accessible to the network as /net/universe/files1 . On the
WabiServer, universe:/files1/wsadmin  is mounted to /home/wsadmin .
For more information on the Automounter, see the Solaris System Administrator
AnswerBook.

▼ To Create a wsadmin User

Follow the steps below to create a wsadmin  user.

1. Log in as root from the login prompt.

2. Start OpenWindows, if it is not started automatically.

3. From within a window, create a wsadmin  user using the admintool  or the
useradd  command (an example of the useradd  command is shown
above).
Give the new user a .login  and a .cshrc  file typical of your site.

4. Give wsadmin  ownership of the wsadmin  home directory.

# chown -R wsadmin /home/wsadmin

5. Give wsadmin  access to the X Windows display.

# /usr/openwin/bin/xhost +

▼ To Create a Directory to Hold Prototypes

Create a directory for prototypes on your WabiServer system using the
following procedure.

1. Check the documentation that comes with your applications to determine
the amount of disk space you need.

2. Select a location on the server that has enough disk space to hold the
applications you plan to install.
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3. Check that the prototype directory is on a file system that is exported
(with an entry in dfstab  file as described above).

4. Create the directory and give wsadmin  ownership of this directory.

# mkdir /files1/protos
# chown wsadmin /files1/protos

Create a Windows Only Prototype
Follow the steps below to create your first prototype. The only package that the
first prototype will contain is Microsoft Windows. You will be able to build
other prototypes starting with the Windows prototype as a base.

▼ To Create a Windows Only Prototype

1. Change to user wsadmin  using the su -  command.
Using a hyphen causes the system to read the .login  and .cshrc  files for
the new user.

# su - wsadmin
%

2. Start the ws_bldproto  tool.
(See Figure 4-1 on page 55.)

% ws_bldproto

3. Choose the New Proto option.

4. Enter a description of the new prototype. Enter “Windows 3.11.”
We recommend that you create a prototype which contains only Microsoft
Windows. This prototype can then be the basis for any other prototypes you
want to build.

5. Enter a network-aware pathname of the location of the prototype. Enter
/net/venus/files1/protos/win_only , substituting your server’s
name for venus .

A network-aware path is the location of a file or directory as seen by other
systems. If you are using the Automounter, a network-aware path begins
with /net/ server-name .
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In our example, the pathname is an Automounter network pathname. Our
WabiServer system is named venus .

Figure 4-1 ws_bldproto Tool



56 WabiServer Administrator’s Guide—November 1995

4

6. Choose Apply.
A message tells you that Wabi is being started in the new prototype
directory. It tells you to install applications and then exit Wabi.

The Wabi Output Log box opens (Figure 4-2). This shows message output
from Wabi. You can scroll the output if necessary.

Figure 4-2 Wabi Output Log
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Wabi starts (Figure 4-3).

Figure 4-3 Wabi Logo
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The Wabi 2.1 Registration Card Information box opens (Figure 4-4) followed
by the Wabi 2.1 Registration Card (Figure 4-5).

Figure 4-4 Wabi Registration Card Information
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Figure 4-5 Wabi 2.1 Registration Card

7. If you have not yet registered for Wabi 2.1, you can register now.
The program lets you send the registration form automatically by email, or
print out the form so you can mail or fax it to SunSoft. If you would rather
register later, exit the registration program by clicking Cancel. Use the Wabi
Registration tool in the Wabi Tools group to run the registration program at
a more convenient time. If you prefer, you can complete a printed
registration card that is included in the Wabi package.
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The Windows Install dialog opens (Figure 4-6).

Figure 4-6 Windows Install Dialog

8. Put the first diskette in the drive now. Choose OK.
Follow the on-line instructions for inserting the rest of the diskettes.

9. Optional step: When Windows is installed, size and locate the program
groups.
If you size and locate your program group icons now, you will not have to
do it each time you create a new prototype. You are also saving your users
from having to size the program groups.

Be sure that in the Program Manager, in the Options menu, that Save
Settings on Exit is checked.

10. Exit Windows.
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11. In the ws_bldproto  window, choose Yes to create the prototype.
ws_bldproto  reports that it is compressing the new prototype. This takes a
few minutes.

ws_bldproto  reports that your directory was successfully created.

12. Log out as the wsadmin  user.

% logout
#

Your new Windows 3.11 prototype is ready for clients to use.

The next section shows you how to create a prototype that contains a complete
application starting with this prototype as a base.

Create a Prototype from an Existing Prototype
This section creates a prototype that contains Windows 3.11 and the Intuit
Quicken application. It is created using the Inherit Proto option in the
ws_bldproto  tool and is based on the existing Windows prototype.

▼ To Create a Quicken Prototype

1. If you are logged in as another user, change to user wsadmin  using the
su -  command.
(Using a hyphen causes the system to read the .login  and .cshrc  files for
the user.)

# su - wsadmin
%

2. Start the ws_bldproto  tool. (See Figure 4-1 on page 55.)

% ws_bldproto

3. Choose the Inherit Proto option.

4. Select the Windows 3.11 prototype from the prototype list.

5. Enter a description of your prototype. Enter “Quicken.”

6. Enter a network-aware pathname of the location of the prototype. Enter
/net/venus/files1/protos/quicken , substituting your server’s name
for venus .
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A network-aware path is the location of a file or directory as seen by other
systems. If you are using the Automounter, a network-aware path begins
with /net/ server-name .

In our example, the pathname is an Automounter network pathname. Our
WabiServer system is named venus .

7. Choose Apply.
A message tells you that Wabi is being started in the new prototype
directory. It tells you to install applications and then exit Wabi.

The Wabi Output Log window opens.

Wabi starts.

8. Insert the first Quicken disk in the diskette drive.

9. In Wabi, in the Program Manager, select File ➤ Run.

10. Enter a:\install.

11. On the installation screen, choose Express install to install the entire
application or Custom install to select portions to install.
Quicken is installed in a few minutes.

12. In the Quicken Install Dialog Box, choose OK.

13. Exit Wabi.

14. Choose Yes to the question, “Are you ready to generate the prototype?”
If you want to add another application to this prototype, choose No, Restart
Wabi and then install another application.

15. Choose OK to the “Prototype creation complete” message.

The Quicken prototype is complete. It is immediately added to the Base
Prototype list box. You can select Inherit Proto and choose this new prototype
as the base from which to create a new prototype.

Shared Applications
This book uses the term shared applications to refer to applications that are
installed in a server/client configuration; that is, the bulk of the application
resides on a server and is shared by several clients. The server uses a large
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amount of disk space to store the bulk of the application. A client system uses
very little disk space to store a small client portion of application software.
This configuration is supported by both Microsoft Office and Lotus SmartSuite.

The next two sections describe how to install Microsoft Office and Lotus
SmartSuite as shared applications. If you do not want to install either of these
applications, go to the section “Creating Multiple Prototypes” on page 74.

If you are going to install Microsoft Office, Lotus SmartSuite, or any other
application that supports a server/client configuration, enter the following
commands to create a directory in which to put the shared portion of the
application.

▼ To Create a Directory to Hold Shared Applications

1. Log in as root . Create a directory in which to put shared applications.
Give wsadmin  ownership of the directory.

# mkdir /files1/shared_apps
# chown wsadmin /files1/shared_apps

2. Create a link to another location.

# ln -s /files1/shared_apps /opt/SUNWwsvr/wsshared

Drive Mappings
Your drives are mapped as shown in the following table. The C drive is set to
your Wabi directory. From within ws_bldproto , the Wabi directory is set to a
temporary directory in the location you chose for your new prototype.

In our example installation running ws_bldproto , as user wsadmin , your
Wabi directory is /files1/protos/win_only/wabi .

Drive Mapping Definition

C: Your Wabi directory Your Wabi directory.

E: $PWD The directory from which you
started Wabi.

H: $HOME Your home directory.

R: / Your root directory.
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Create a Microsoft Office Prototype
Perform the following steps to install Microsoft Office 4.3 as a shared
application and to create a prototype that contains Windows 3.11 and the client
portion of Microsoft Office 4.3.

▼ To Start ws_bldproto

1. Start the ws_bldproto  tool.

% ws_bldproto

2. Choose the Inherit Proto option.

3. In the prototype list box, select Windows 3.11 as the prototype to use as a
base for the new prototype.

4. Enter a description of the new prototype. Enter “Microsoft Office.”

5. Enter the network-aware pathname of the location where you want your
Microsoft Office prototype. Enter
/net/venus/files1/protos/msoffice , substituting the name of your
server for venus .

6. Choose Apply.
A message tells you that you will be installing applications under Wabi.

Wabi starts.

▼ To Map the S Drive

In this step, you use the Wabi Config Drives tool to set drive S to
/opt/SUNWwsvr/wsshared.  Mapping a drive to the shared application
directory facilitates installation. We chose the S drive so that S will remind us
of “shared.” (For more information on the Wabi Config Drives tool, see the
Wabi User’s Guide.)

1. Open the following icons in the Program Manager: Main ➤ Control Panel
➤ Wabi Config ➤ Drives.

2. Select drive S in the Drives list box.
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3. Enter /opt/SUNWwsvr/wsshared  in the directory path edit box.
Use the name of the link to the shared application location. Do not use the
Automounter network-aware path here. (/opt/SUNWwsvr/wsshared  is a
link to /files1/shared_apps , which you created in “To Create a
Directory to Hold Shared Applications” on page 63.)

4. Choose Connect.

5. Choose OK.

6. Using the menu from the Window Control box (upper left corner of the
window), close the following program groups: Drives, Wabi Config, and
Control Panel.

Install Microsoft Office

This section describes how to install Microsoft Office as a shared application.
You install Microsoft Office as a shared application in two broad steps:

1. First you install the server portion of the application into the shared_apps
directory.

2. Then you install the client portion of the application. In this case, you are
installing the client portion into the prototype, which will become a user‘s
wabi  directory.

▼ To Install the Server Portion in the shared_apps Directory

To install the portion of Microsoft Office software that will be shared, follow
the steps below. These steps follow the directions in the provided Microsoft
documentation, Getting Started, in the section “Installing Microsoft Office on a
Network.” The following steps add information specific to this environment.

1. Move the mouse to the Program Manager window and click to activate the
window.

2. Choose File ➤ Run from the Program Manager.

3. Check that your S drive is mapped to /opt/SUNWwsvr/wsshared.

a. Choose Browse in the Run dialog box.
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b. Check that the S drive is mapped in the Drives list.
If the S drive is not mapped, follow the directions in “To Map the S
Drive” on page 64.

4. Put disk 1 into the diskette drive.

5. Enter a:setup /a

6. Answer the prompts as follows, where appropriate to your installation.
This is a summary of our answers. If this is your first time through, read all
of the boxes and answer as applicable for your site.

a. Choose OK to the Welcome box

b. Choose OK to the Shared Network Installation box.

c. In the Organization Information screen, type the name of your
organization.
Possible Error: (If this box also asks you for a Name, you neglected to
run setup  with the /a  option. If this is the case, select Exit Setup and
start over, using the /a  option.

d. Choose OK to the Confirm Organization Information box.

e. Write down your product ID for future reference.

f. Choose OK to the Product ID box.

g. In the destination directory box, Choose Change directory.

i. In the drives box, select S.

ii. In the Path box, enter S:\msoffice .

iii. Choose OK.

iv. Choose Yes to “Do you want the directory to be created?”

h. Choose OK to the shared applications directory as s:\msapps . Yes to
“Do you want the directory to be created?”
In this question, by “shared applications,” they are referring to small
applications that are accessible by a few of Microsoft Office’s major
applications.

i. In the Network Server Confirmation box, delete the entry in the
network server name box; this box should be empty. In the network
pathname box, enter \msoffice .
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j. Choose Complete install.
It takes up to 25 minutes to install Microsoft Office.

k. Choose Continue to Restart Windows.

l. Set permissions on an msoffice  directory.

# chmod 0777 shared_apps/msoffice/workdir/*

You have finished the installation of the shared portion of Microsoft Office. You
cannot test the installation until you have installed the client portion using the
instructions in the next section. Installing the client portion takes only a few
minutes.

▼ To Install the Client Portion in the Prototype

Follow the steps below to install the client portion for the Microsoft Office
prototype.

1. Choose File ➤ Run from the Program Manager.

2. In the Run dialog box, select the Browse button.

3. In the Browse dialog box, in the Drives list, select the S drive.

4. Select the setup.exe  file. Choose OK

5. Choose OK to run the command.

6. Answer the prompts as follows, where appropriate to your installation.
This is a summary of our answers. If this is your first time through, read all
of the boxes and answer as applicable for your site.

a. Choose OK to the Welcome box.

b. In the Name Information box, type wsadmin  as your name. Choose
OK.

c. Choose OK to the Confirm Name Information box.

d. Choose OK to the Product ID box.

e. Choose OK to the box “Setup will install Microsoft Office Manager in
the following destination directory: C:\msoffice.”

7. Choose OK for the next four prompts to install specific applications in
c:\msoffice .
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a. Choose Workstation install in the Type of Installation box.Possible
error: If this box does not give Workstation install as an option,
something is wrong. You may have started the wrong setup program, or
you did not install Microsoft Office as a shared application. Exit and
check your work from the beginning.

b. Our choices for the next three boxes are No, Yes, No.
Read these boxes and answer as appropriate for your site for whether
you want help for transitioning form Lotus 1-2-3, Graph Auto
Conversion, or help for WordPerfect Users.

c. Choose Microsoft Office as the Program Group in which to install the
icons.
It takes up to 15 minutes to install the client portion of Microsoft Office.

Possible Error: If you installed from diskettes, you might get an error
message saying the you are missing the vshare.386  file. If you get this
error, you must obtain a vshare.386  file. See your Sun Customer
Service Representative.

d. Choose Continue to Restart Windows.
Wabi and Windows restart.

8. Before the prototype is stored, you have a chance to customize the
installation for your users. We recommend the following.
To help ensure that users don't save personal material in their C drive (their
Wabi directories, which may be replaced by different Wabi directories later),
you should set as many default file-saving locations as possible to be H:\
(the user’s home directory) when building the prototypes.

a. Size and locate the Microsoft Office program groups nicely for your
users.
This step gives a new client user windows that are usefully sized.

b. In Microsoft Word:
Select Tools ➤ Options ➤ Documents.
Set Documents to H:\.
Set User Options to H:\.

c. In Microsoft Excel:
Select Tools ➤ Options ➤ General.
Set Default File Locations to H:.\

d. Be sure that in the Program Manager, in the Options menu, that Save
Settings on Exit is checked.
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9. Exit Wabi.

10. Choose Yes to the question, “Are you ready to generate the prototype?”
If you want to add another application to this prototype, choose No, Restart
Wabi and then install another application.

11. Choose OK to the “Prototype creation complete” message.

The Microsoft Office prototype is complete. It is immediately added to the list
in the Base Prototype list box. You can select Inherit Proto and choose this new
prototype as the base from which to create a new prototype.

You can follow the directions below to install Lotus SmartSuite in another
prototype. If you do not want to install Lotus SmartSuite, you now have the
tools to create other prototypes with other applications if you wish. If you do
not want to install Lotus SmartSuite, go to “Creating Multiple Prototypes” on
page 74.

Create a Lotus SmartSuite Prototype
Follow the procedures in this section to install Lotus SmartSuite as a shared
application and to create a prototype that contains Windows 3.11 and the client
portion of Lotus SmartSuite.

▼ To Start ws_bldproto

1. Start the ws_bldproto  tool.

% ws_bldproto

2. Choose the Inherit Proto option.

3. In the prototype list box, select Windows 3.11 as the prototype from which
to start building.

4. Enter a description of the prototype. Enter “Lotus SmartSuite.”

5. Enter the full pathname of the location of the Lotus SmartSuite prototype.
Enter /net/venus/files1/protos/lotusst , substituting the name of
your server for venus .
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6. Choose Apply.
A message tells you that you will be installing applications under Wabi

Wabi starts.

▼ To Map the S Drive

In this step, you use the Wabi Config Drives tool to set drive S to
/opt/SUNWwsvr/wsshared . Having a drive mapped to the shared
application directory facilitates installation. We chose the S drive so that S will
remind us of “shared.”

1. Open the following icons in the Program Manager: Main ➤ Control Panel
➤ Wabi Config ➤ Drives.

2. Select drive S in the Drives list box.

3. Enter /opt/SUNWwsvr/wsshared  in the directory path edit box.
Use the name of the link to the shared application location. Do not use the
Automounter network-aware path here. (/opt/SUNWwsvr/wsshared  is a
link to /files1/shared_apps , which you created in “To Create a
Directory to Hold Shared Applications” on page 63.)

4. Choose Connect.

5. Choose OK.

6. Using the menu from the Window Control box (upper left corner of the
window), close the following program groups: Drives, Wabi Config, and
Control Panel.

Install Lotus SmartSuite

This section describes how to install Lotus SmartSuite as a shared application.
You install Lotus SmartSuite as a shared application in two broad steps.

1. First you install the server portion of the application into the shared_apps
directory.

2. Then you install the client portion of the application. In this case, you are
installing the client portion into the prototype, which will be used to create
a user‘s Wabi directory.
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▼ To Install the Server Portion in the shared_apps Directory

To install the portion of Lotus SmartSuite software that will be shared, follow
the steps below.

1. Move the mouse to the Program Manager window and click to activate the
window.

2. From the Program Manager, select File ➤ Run.

3. Check that your S drive is mapped to /opt/SUNWwsvr/wsshared.

a. Choose Browse in the Run dialog box.

b. Check that the S drive is mapped in the Drives list.
If the S drive is not mapped, follow the directions in “To Map the S
Drive” on page 70.

4. Insert Disk 1 in the diskette drive.

5. In the Run dialog box, enter a:install.

6. Answer the prompts as follows.
This is a quick summary of our answers. If this is your first time through,
read all of the boxes to ensure that these answers correctly apply to you.
Selecting Next in this set of steps means that you accept the box as is. The
system then displays the next box.

a. In the Welcome to the Lotus SmartSuite Install Program box:

i. Enter your name as wsadmin .

ii. Enter a name for your organization.

iii. Select Install on a File Server.

iv. Choose Next to go to the next box.

b. Choose Yes in the Confirm Names box.

c. Choose Next to the Server Install or Network Distribution box
Leave the Server Install selected.

d. Choose Next to the Network Administrator’s Guide box.
Leave the guide unopened.

e. In the Specify Lotus SmartSuite Directory box:

i. Select the drive as S.
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ii. Select the directory as \lotus .

iii. Choose Next to go to the next box.

We selected 5 Nexts to the next 5 questions as follows:

f. Choose Next to the Specify Lotus Shared Tools Directory box.
Leave drive S, and \lotus\lotusapp \ selected.

g. Choose Next to the Select Lotus SmartSuite Applications box.
Leave as is to select to install the complete list of applications.

h. Choose Next to the Install Options box.
Leave Automatic Install selected.

i. Choose Next to the SQI server Name box.
Leave entry box blank.

j. Choose Next to the Paradox Network Information box.
This skips the Paradox drivers install.

k. In the Lotus Licenser box, uncheck the Lotus Licenser option to disable
the licenser. Choose Next.
If you leave this box checked, you will have trouble running SmartSuite
as a shared application.

l. Choose next to the Select Program Group box.
This leaves Lotus Applications as the name of the Program Group.

m. Choose Yes in the Begin Copying Files box.
This starts the files copying process. It takes a while to load SmartSuite.

n. Choose Done in the Install Complete box.

▼ To Install the Client Portion in the Prototype

This begins the client portion of the install in the prototype.

1. Double click on the Run Node Install icon to begin the client installation.

2. Answer the prompts as follows.
This is a quick summary of our answers. If this is your first time through,
read all of the boxes to ensure that these answers correctly apply to you.
Selecting Next in this set of steps means that you accept the box as is. The
system then displays the next box.

a. In the Welcome to the Lotus SmartSuite Install Program box:
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i. Enter your name as wsadmin .

ii. Leave the name of your organization as is.

iii. Choose Next to go to the next box.

b. Choose Yes in the Confirm Names box.

c. Choose Next to the Specify Lotus SmartSuite Directory box.
Leave the directory as c:\lotsuite.

Your C drive is mapped to a temporary Wabi directory in your prototype
location.

d. Choose Next to the Select Lotus SmartSuite Applications box.
Leave as is to select to install the complete list of applications.

e. Choose Next to the Specify Lotus Shared Tools Directory box.
Leave drive C, and \windows\lotusapp \ selected.

f. In the Node Options box, uncheck Copy features to hard disk.
This prevents copying sample files to the client’s disk, which users will
access rarely. If you check this option, it adds 10 Mbyte to the user’s
Wabi directory.

g. Choose Next to the Freelance Graphics Default Preferences box.

h. Choose next to the Select Program Group box.
This leaves Lotus Applications as the name of the Program Group.

i. Choose Yes in the Begin Copying Files box.
This starts the files copying process. It takes a while to load SmartSuite.

j. Choose Done in the Install Complete box.

3. Optional. Before the client portion is compressed for the prototype, you
have a chance to customize the installation for your users. We recommend
the following.
We recommend that users don't save personal material in their C drive
(their Wabi directories), which may be replaced by different Wabi directories
later. You might want to set default file-saving locations to the H drive (the
user’s home directory) when building the prototypes.

a. Size and locate the program groups nicely for your users.
This step gives a new client user windows that are usefully sized.
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b. In Lotus 1-2-3:
Select Tools ➤ User Setup.
Set the Worksheet Directory to H:\.

c. In Lotus AmiPro:
Select Tools ➤ User Setup ➤ Paths.
Set Document to H:\.

d. In Freelance Graphics:
Select Tools ➤ User Setup.
Set Directories to H:\.

e. Be sure that in the Program Manager, in the Options menu, that Save
Settings on Exit is checked.

4. Exit Wabi.

5. Choose Yes to the question, “Are you ready to generate the prototype?”
If you want to add another application to this prototype, choose No, Restart
Wabi and then install another application.

6. Choose OK to the “Prototype creation complete” message.

The Lotus SmartSuite prototype is complete. It is immediately added to the list
in the Base Prototype list box. You can select Inherit Proto and choose this new
prototype as the base from which to create a new prototype.

You can follow the directions below to install Lotus SmartSuite in another
prototype. If you do not want to install Lotus SmartSuite, you now have the
tools to create other prototypes with other applications if you wish.

Creating Multiple Prototypes
You can create prototypes that contain any number of applications. Here are
some examples of how you can use the ws_bldproto  tool:

• You can create a prototype starting with the Windows 3.11 prototype and
add one or more complete application, such as Quicken or Microsoft Project.

• You can create a prototype starting with any previous prototype using the
Inherit Proto option.

• You can create a prototype from an existing Wabi directory using the Copy
Wabidir option.
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• You can create a link to a prototype on another server to make it available to
users on the current server using the Link Proto option.

• You can create a link to a prototype on another server using the Link Proto
option and start a prototype from that prototype using the Inherit Proto
option.

See “Building Prototypes with ws_bldproto” on page 95 for details on using
ws_bldproto .

Note – Using the Copy Wabidir option to create a prototype has a drawback.
Users running a Wabi directory from a prototype made in this manner will be
unable to open Wabi application files from within the OpenWindows File
Manager or Mail Tool. Specifically binding information (classing engine
information) will not be included in the prototype.

To prevent this, do not create prototypes from existing Wabi directories.
Instead, start with no prototype or an existing prototype and re-install the
relevant software.

If you run ws_bldproto  on a system that is not running OpenWindows,
binding information also might not be included in the prototypes.

If you create a link to a prototype on another WabiServer, users will be able to
access that prototype when they are connected to the current WabiServer.

Users’ performance will be better with shared applications if shared software
resides on the current WabiServer and not on a remote file server or another
WabiServer. If you create a link to a prototype on another WabiServer that
points to shared software, move a copy of the shared software to the current
WabiServer.

See “Using a Linked Prototype with Shared Applications” on page 102 for
details on this procedure.
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Installing WabiServer Client
Software on Clients 5

WabiServer client software provides programs, libraries, and configuration
information needed to start Wabi on the server and display back to the user’s
screen. Before users can run WabiServer, they must have access to the
WabiServer client software.

You can make the WabiServer client software accessible to the client system in
one of two ways:

• Install the client software locally on client systems.

• Install the client software on the server and mount it from client systems.

You may also need to install Solaris patches on the client system to prevent
possible display problems.

Preparing for Client Installation
To install a workstation as a WabiServer client, you will perform these steps.
The instructions for each step are described in the following chapters.

1. Install Solaris patches, if needed.

2. Provide access to the WabiServer package.
• You can mount client software from the server.
• Or you can install the WabiServer client package from CD-ROM onto the

client system.

3. Disable Volume Manager to enable the local diskette drive.
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The first time you run Wabi remotely on a client, you will:

1. Add a directory name to your path.

2. Start the rwabi  program.

3. Select a WabiServer.

4. Name the Wabi directory.

5. If the named Wabi directory does not exist, you are asked for the name of a
prototype from which to create a Wabi directory.

Starting Client Installation
Find the bullet below that applies to your installation and go to the named
section.

• If you are a new installation; that is, if you are currently not running
standalone Wabi or WabiServer client software, skip to the section for the
client’s operating system, either “Client Installation on a Solaris System” on
page 80 or “Client Installation on a SunOS System” on page 86.

• If you have been running standalone Wabi, you may want to remove it. If
you are becoming a WabiServer client, you do not need standalone Wabi.
You are not, however, required to remove an existing standalone Wabi
package. If you want to remove Wabi, go to the next section, “Remove
Existing Packages.”

• If you are running a previous version of WabiServer client software, you
need to remove the previous version before loading this version. Go to the
next section, “Remove Existing Packages.”

Remove Existing Packages
Follow the procedures below to remove an existing Wabi package or an
existing WabiServer package from a Solaris system, if appropriate.
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▼ To Remove an Existing Wabi Package

1. Check for installed Wabi patches by entering the following commands.

% showrev -p | grep SUNWwabi
any output such as:
Patch: 102330-02 Obsoletes: Packages: SUNWwabi 2.0,PAT

2. Identify which line applies to you and follow the instructions:
• If you have no Wabi patches installed, go to Step 3.
• If you have Wabi patches, enter the following command for each patch,

replacing patch-id with the patch number.

% su
# /var/sadm/patch/ patch-id /backoutpatch patch-id

3. Become superuser if you are not already.

4. Enter the following command to remove the Wabi package.

# pkgrm SUNWwabi

When you press Return, the pkgrm  program displays a message similar to
the following:

5. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

6. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

The following package is currently installed:

SUNWwabi   Wabi Application

Do you want to remove this package [y,n,?,q]

Removal of <SUNWwabi> was successful.
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If you are not running a WabiServer client package that you need to remove,
go to the section called “Client Installation on a Solaris System” on page 80.

▼ To Remove an Existing WabiServer Client Package

1. Become superuser if you are not already.

2. Enter the following command to remove the WabiServer client package.

# pkgrm SUNWwclt

When you press Return, the pkgrm  program displays a message similar to
the following:

3. Enter y  to start the removal process.
A prompt notifies you that the package scripts will be run with superuser
permission, and asks you if you want to continue.

4. Enter y  to continue with the removal.
File names and system messages are displayed at the command line as
various components of the Wabi package are removed.

The pkgrm  program displays the following message when the package
removal is complete.

Client Installation on a Solaris System
This section gives procedures for installing WabiServer client software on a
Solaris client system. Start here if this is the first time you are installing
WabiServer client software on this system or if you have completed the steps in
the previous section “Remove Existing Packages” on page 78.

The following package is currently installed:

SUNWwclt   WabiServer Client Application

Do you want to remove this package [y,n,?,q]

Removal of <SUNWwclt> was successful.
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Install Solaris Patches from the WabiServer Client CD-ROM

The WabiServer 1.0 Read This First contain information about Solaris patches
you may need to install before using the WabiServer client program. The
patches are included on the WabiServer Client CD-ROM. (If you are running a
standalone Wabi package simultaneously, you may already have installed
versions of the patches that are sufficient to fix any potential Wabi problems.)

♦ Follow the instructions in the WabiServer 1.0 Read This First to see if you
need to install any patches from the client CD-ROM onto the client
system.

Provide Access to the WabiServer Package

You can provide access to the WabiServer client package on the client by either
mounting and linking to the software on the server or by installing a
SUNWwclt package from the client CD-ROM. From the following bulleted
items, select the one that describes your situation and go to the indicated
procedure.

• If you want to mount the client software from the server, go to the
procedure “To Mount Client Software from the Server” on page 81.

• If you want to install the client software from the CD-ROM, go to the
procedure “To Install Client Software from CD-ROM” on page 82.

▼ To Mount Client Software from the Server

This section assumes that you installed the WabiServer client package when
you ran pkgadd  when you installed the server. If you did not yet install the
WabiServer client software on the server and wish to install it on the server
now, follow the instructions in “Server Installation” on page 43 and select the
WabiServer client package.

If you are running the Automounter, you must be sure that the
/opt/SUNWwsvr  file system is exported. (See the Solaris System Administrator
Answerbook for instructions on exporting file systems.) If the WabiServer client
software is installed on the server and the server’s /opt/SUNWwsvr  file system
is exported, you can skip this procedure and go straight to the section called
“Add the SUNWwclt Directory to Your Path” on page 87.
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If you are not running the Automounter, perform the following steps to mount
the client software from the server.

1. Enter the following command as root:

# mkdir /opt/SUNWwclt

2. Add the following line to the /etc/vfstab  file, substituting your
server’s name for venus :

venus :/opt/SUNWwclt - /opt/SUNWwclt ufs - yes

3. Enter the following command to mount the /opt/SUNWwclt  file system.

# mount -a

▼ To Install Client Software from CD-ROM

1. If you do not know whether or not you are using Volume Manager, enter
the following command:

# ps -ef | grep vold

If the process /usr/sbin/vold  is reported, you are using Volume
Manager. If the command gives you no output, you are not using Volume
Manager.

2. If you are using the Solaris Volume Manager, insert the WabiServer client
CD-ROM into the CD-ROM drive.
The CD-ROM file system is mounted automatically. Go to “Run pkgadd” on
page 83.

3. If you are not using the Solaris Volume Manager, create a mount point
before inserting the CD-ROM into the CD-ROM drive and then mount
the CD-ROM.

a. If you do not already have a /cdrom  directory, create one as superuser
by entering:

# mkdir /cdrom

b. Insert the WabiServer client CD-ROM into the CD-ROM drive.
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c. Mount the CD-ROM with one of the following commands, depending
on which version of Solaris you have:

SPARC# mount -o ro -F hsfs /dev/dsk/c0t6d0s2 /cdrom

x86# mount -o ro -F hsfs /dev/dsk/c0t6d0p0 /cdrom

Note – The c0t6d0s2  and c0t6d0p0  device numbers used in these
commands assume your CD-ROM drive is set to SCSI target number 6. If you
get the response “no such device,” your CD-ROM probably uses a different
SCSI target number. If target number 6 did not work, enter ls -l /dev/sr0
to find your target number.

Run pkgadd

On a Solaris client, use the pkgadd  command to copy the WabiServer client
package to your system.

▼ To Run pkgadd

1. Enter the following command according to whether you are using Volume
Manager or not.

 If you are using Volume Manager, enter:

SPARC# pkgadd -d /cdrom/wabiserver_1_0/sparc

x86# pkgadd -d /cdrom/wabiserver_1_0/i86

If you are not using Volume Manager, enter:

SPARC# pkgadd -d /cdrom/sparc

x86# pkgadd -d /cdrom/i86
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When you press Return, the pkgadd  program displays a screen similar to
the following (with some additional detail):

2. Select one or both packages to install.  Either
• Press Return to select both packages.
• Enter a number to select one package.

The pkadd  program begins the installation process.

3. If you have Volume Manager’s control of the diskette drive enabled,
pkgadd  displays the following prompt:

If you want to use the local diskette drive with remote Wabi, enter y.

If you want to use the local diskette drive with Volume Manager in the
Solaris environment, enter n.

If you enter y, the pkgadd  program disables Volume Manager’s control of
the diskette drive. See the Wabi Release Notes for information about the
command to use to enable and disable Volume Manager’s control of the
diskette drive at any time.

The following packages are available:

1 SUNWaws Wabi User’s Guide
(all)

2 SUNWwclt WabiServer Client-side Application
(i86,sun4-Solaris,sun4-SunOS) 1.0

Select package(s) you wish to process (or “all” to process
all packages). (default all) [?,??,q]:

To use your diskette drive under Wabi, we recommend that you
disable Volume Manager's control of the diskette drive.

Would you like this done now?
Yes or No [y,n,?,q]
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4. The pkgadd  program prompts:

Enter y  to proceed with the installation.

As the installation nears completion, you may see the following message:

This message is not applicable to a client installation on WabiServer. You
cannot use serial ports through Wabi on a WabiServer client system.

When all WabiServer client files have been installed, the following message
is displayed

5. Enter q to quit.

When the installation is complete, go to the section “Setting Up Users” on
page 87.

This package contains scripts which will be executed with
super-user permission during the process of installing this
package.

Do you want to continue with the installation of this
package [y,n,?]

If you would like to use the UNIX serial ports in Wabi, please
run the following command as root:

chmod 666 /dev/cua/*
This gives ordinary users read/write permissions to the
serial devices, allowing them to use these ports from Wabi.

Installation of <SUNWwclt> was successful.

The following packages are available:

1 SUNWaws Wabi User’s Guide
(all)

2 SUNWwclt WabiServer Client-side Application
(i86,sun4-Solaris,sun4-SunOS) 1.0

Select package(s) you wish to process (or “all” to process
all packages). (default all) [?,??,q]:
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Client Installation on a SunOS System
To install client software on a SunOS client system, follow the instructions in
this section.

Provide Access to the WabiServer Package

You can provide access to the WabiServer client package on the client by either
mounting client software from the server or by installing client software from
the client CD-ROM. Select the bulleted item from the list below that describes
your situation and go to the indicated procedure.

• If you want to mount the client software from the server, go to the
procedure “To Mount Client Software from the Server” on page 81.

• If you want to install the client software from the CD-ROM, go to the
procedure “To Install Client Software from CD-ROM” on page 82.

▼ To Mount Client Software From the Server

This section assumes that you selected to install the WabiServer client package
when you ran the pkgadd  command during the server installation. If you did
not yet install the WabiServer client software on the server and wish to install
it on the server now, follow the instructions in “Server Installation” on page 43
and select the WabiServer client package.

If you are running the Automounter, you must be sure that the
/opt/SUNWwsvr file system is exported. (See the SunOS system
administration documentation for instructions on how to mount file systems.)
If the WabiServer client software is installed on the server and the server’s
/opt/SUNWwsvr  file system is exported, you can skip this procedure and go
straight to the section called “Add the SUNWwclt Directory to Your Path” on
page 87.

If you are not running the Automounter, perform the following steps to mount
the client software from the server.

1. Enter the following command as root:

# mkdir /opt/SUNWwclt
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2. Add the following line to the /etc/fstab  file, substituting your server’s
name for venus :

venus :/opt/SUNWwclt /opt/SUNWwclt nfs rw,hard,fg 0 0

3. Enter the following command to mount the /opt/SUNWwclt  file system.

# mount -a

▼ To Install Client Software From CD-ROM

Create a mount point before inserting the CD-ROM into the CD-ROM drive
and then mount the CD-ROM.

1. If you do not already have a /cdrom  directory, create one as superuser by
entering:

# mkdir /cdrom

2. Insert the CD-ROM into the CD-ROM drive.

3. Enter the following command to mount the CD-ROM.

# mount -r -t hsfs /dev/sr0 /cdrom

4. Change the directory to the location of the SUNWwclt package for a
SPARC system and run the install_unbundled  command.

# cd /cdrom/wabiserver_1_0/sparc/SUNWwclt/install
# ./install_unbundled

When the installation is complete, go to the next section “Setting Up Users.”

Note – The Wabi User’s Guide AnswerBook is not available for SunOS clients.

Setting Up Users
To set yourself (or another user) up as a WabiServer user, follow the steps
below.

Add the SUNWwclt Directory to Your Path

Log in as the user you are installing. Use a text editor to edit the .login  file,
adding the path name of the SUNWwclt software.
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• If the client software is installed on the client or if you are mounting the
client software form the server, but are not using the Automounter, the path
is /opt/SUNWwclt/bin .

• If you are using the Automounter and mounting the server’s client package,
the path is /net/ server-name /opt/SUNWwclt/bin .

This example uses the vi  editor. (If you need more information on using vi ,
see the Solaris User Answerbook.)

% cd ~
% vi .login
Add directory to the path variable.
:wq
%

Running rwabi for the First Time on the Client

The first time you run rwabi , you are asked for the name of a WabiServer on
which to run and a name for your Wabi directory.

Note – To access help for any of the WabiServer tools, put your cursor on the
item for which you want help and press the Help key.

Figure 5-1 rwabi_setup Tool
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Enter the name of the appropriate WabiServer.

Enter the name of a directory that will be your Wabi directory. You might want
to use a name, as in Figure 5-1, that describes the applications that this Wabi
directory will contain. Figure 5-1 uses the name wabi-msoff  because it will
contain Microsoft Office. (You have the option to create more than one Wabi
directory that contain different applications. Descriptive names will help you
identify them.)

If you enter the name of an existing Wabi directory, rwabi  is immediately
started on the server you named using the existing Wabi directory.

If the Wabi directory that you name does not exist, you are asked for the name
of a prototype directory (see Figure 5-2 on page 90). The prototype directory is
used to create a new Wabi directory for you in the location you named.

The prototype directories listed are those that are established on the selected
WabiServer (they either exist on the server or are linked from another server).

Each prototype lists the amount of disk space you need in your Wabi directory
for the applications in the prototype. Check that you have sufficient disk space
for the prototype that contains the applications you need. Select the desired
prototype.

Note – You must have a license to run any application that you use. To run an
application without a license is a violation of Federal copyright law.
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Figure 5-2 rwabi_selproto Tool

▼ To Run rwabi for the First Time

You will perform the following sequence of steps when you run Wabi remotely
for the first time.

1. Enter the rwabi command.
The rwabi_setup  tool is started (see Figure 5-1).

2. Enter the name of the WabiServer on which you want to run.

3. Enter the full path name of your desired Wabi directory.
The rwabi_selproto  tool is started (see Figure 5-2).

4. Select the prototype from the list that contains the applications that you
need.

5. Choose Apply.

You Wabi directory is created in a few minutes and Wabi is started.
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Wabi Directory

Usually, the initial run of rwabi  creates your Wabi directory in the location
you specify in the rwabi_setup  utility.

There are two exceptions to this:

• If the Wabi directory you specify already exists, a new one is not created.

• If the WABIDIR environment variable is set, then this setting is used instead
of the one you specified in the rwabi_setup  utility.

The Wabi directory contains your own copy of Windows software (modified
for Wabi) and may also contain application software depending on the
prototype you used in its creation.

Note – You may not want to save files in your C drive; that is, you may not
want to save files in your Wabi directory.

By default, you Wabi directory is mapped to your C drive. Most Windows
applications are started in the C drive and files are saved in the C drive. Check
the application documentation to set the file-saving location to another
location. (See “To Install the Client Portion in the Prototype” on page 67 for
directions on how to set the file-saving locations for Word and Excel.)

If you change to a different prototype directory, using the same Wabi directory
name, your Wabi directory is overwritten and you lose any personal files you
saved there.
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Administrator Tools 6

How To View AnswerBook
To view the Wabi and WabiServer on-line documentation, start AnswerBook
and double-click on the title you want to view. See your Solaris documentation
for information about using AnswerBook. The Wabi User’s Guide explains how
to use the Wabi Configuration tools to map drives and set up printers.

Also, be sure to read the Wabi Release Notes, available in the Wabi Tools
program group, to find release information about the standalone Wabi
package, which is run as part of WabiServer.

Setting Access to Printers and Diskette Drives with ws_setup
By default, users can use the diskette drives on their own systems and can
access printers configured on both the client system and the WabiServer. To
limit users’ access to printers and diskette drives, run the ws_setup  program
(see Figure 6-1). You must be logged in as root to run the ws_setup  tool.In the
dialog box that opens, you can choose from the following options.

For printers (see Figure 6-2), you can:

• Allow users access to only the printers configured on the client systems

• Allow users access to only the printers configured on the server systems

• Allow users access to the printers configured on both the client system and
the WabiServer.
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Figure 6-1 ws_setup Tool

Figure 6-2 Printer Access Options in the ws_setup Tool

For diskette drives (see Figure 6-3), you can:

• Allow users to use the diskette drives on the client system.

• Allow users to use the diskette drives on the WabiServer.

• Allow users to use no diskette drives.

Figure 6-3 Disk Access Options in the ws_setup Tool
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Building Prototypes with ws_bldproto
You can build prototypes using the ws_bldproto  tool. Prototypes contain
Microsoft Windows software and may contain other applications. Prototypes
create Wabi directories that contain the same applications that the prototype
contains.

When a user runs Wabi remotely for the first time, the user selects a prototype
to use to create the Wabi directory. The Wabi directory is created and contains
the same applications that the prototype contains, ready for the user to run.
Users, therefore, do not have to install applications themselves. The
ws_bldproto  tool is a WabiServer tool that enables you to create prototypes.

This section describes how to use the ws_bldproto  tool. For examples of
using the ws_bldproto  tool to create prototypes, see Chapter 4.

The ws_bldproto  tool gives you four ways to create a prototype on the
current Wabiserver. The four ways are described in the following sections. The
four ways are accessed by the four buttons at the top of the ws_bldproto  tool
(see Figure 6-4). They are:

• New Proto
• Inherit Proto
• Copy WabiDir
• Link Proto

Note – Do not run more than one session of ws_bldproto  at a time. Running
more than one session of ws_bldproto  at a time could create corrupt
prototypes.
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Figure 6-4 ws_bldproto Tool

Moving the Cursor

Choose a creation option from the top row of buttons by pointing the cursor
and clicking. You can move the focus from option to option using the arrow
keys. You can move from field to field using the Tab key. Only the fields that
are used with the chosen option will be active once an option is chosen.
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Help in ws_bldproto

To see an on-line help message for any screen or text item, move the focus to
the item with the cursor or the Tab key and press the help key.

New Proto

Choose the New Proto option to create a prototype from scratch. You will
always begin a prototype created with the New Proto option by installing
Microsoft Windows. All prototypes contain Microsoft Windows. The smallest
prototype you can create contains only Microsoft Windows. We recommend
that you create a prototype that contains only Microsoft Windows and use it as
a base for creating other prototypes.

When you select the New Proto option, the Description and the Network-
aware Path boxes become active; they are no longer grayed out. You need to
supply a Description and a location for your new prototype.

The description can be any length. Users can size the rwabi_selproto  tool
screen to see a wide description, up to the size of their terminal screen. You can
use the left and right arrow keys to move your cursor in the description and
path boxes. This description will be what you and users see in the prototype
list. We recommend that you use a description that identifies the prototype’s
contents. For instance, your first prototype might be called “Windows 3.11.”

We suggest you keep all your prototypes together in a single directory, such as
/files/protos and give each prototype a descriptive name. Your path must
be accessible to users, usually in an exported file system.

▼ To Create a New Prototype

Follow this procedure to create a new prototype:

1. Choose the New Proto option.

2. Enter a description.
Enter a description that identifies the planned contents of the new
prototype.

3. Enter the full path name of a location where the prototype will be created
and stored.



98 WabiServer Administrator’s Guide—November 1995

6

4. Choose Apply.
You see the Wabi registration card, which you can fill out now or at a later
date. You are asked to install Windows.

5. Install Windows.
At this point, you can size and locate program groups for convenience, if
you wish.

6. Exit Wabi.

7. Respond appropriately to the question, “Are you ready to generate the
prototype?”
If you want to install another application, select No, Restart Wabi. When
Wabi restarts, install another application, using that application’s
installation instructions.

If you do not want to install another application, select Yes.

8. Choose OK to the “Prototype creation complete” message.

When the new prototype creation is complete, it is immediately added to the
entries in the Base Prototype list box. You can select Inherit Proto and choose
this new prototype as the base from which to create another prototype.

The new prototype is also displayed in the list of available prototypes when
users access this WabiServer using the rwabi -select  command.

For an example of using the New Proto option, see Chapter 4, the section
called “Create a Windows Only Prototype” on page 54.

Inherit Proto

Choose the Inherit Proto option to create a prototype from an existing
prototype. You will probably use this option often starting with your prototype
that contains only Microsoft Windows.

When you select the Inherit Proto option, the Base Prototype prompt becomes
active and available prototypes are displayed in the list box.

▼ To Create a Prototype from an Inherited Prototype

Follow this procedure to inherit a prototype:
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1. Choose the Inherit proto option.

2. Choose one of the available prototypes.

3. Enter a description of the prototype you intend to create
Enter a description that identifies the planned contents of the new
prototype.

4. Enter the full path name of the location where you want the new
prototype.

5. Choose Apply.
The tool copies the named prototype to the new location. Wabi is started.

6. In Wabi, in the Program Manager, select File ➤ Run.

7. Enter the path to the software you are installing according to your
application’s instructions.

8. Complete the application installation according to the application’s
instructions.
When the installation is complete, you can size and locate windows in a
useful manner.

9. Exit Wabi.

10. Respond appropriately to the question, “Are you ready to generate the
prototype?”
If you want to install another application, select No, Restart Wabi. When
Wabi restarts, install another application, using that application’s
installation instructions.

If you do not want to install another application, select Yes.

11. Choose OK to the “Prototype creation complete” message.

The new prototype is immediately added to the entries in the Base Prototype
list box. You can select Inherit Proto and choose this new prototype as the base
from which to create a new prototype.

The new prototype is also displayed in the list of available prototypes when
users access this WabiServer using the rwabi -select  command.
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Copy WabiDir

Choose the Copy WabiDir option if you have an existing Wabi directory in
which you have installed applications and you want to make a prototype that
contains these applications without having to reinstall them.

Note – There is a drawback to using this method. Users running a Wabi
directory from a prototype made in this manner will be unable to open Wabi
application files from within the OpenWindows File Manager or Mail Tool.
Specifically binding information (classing engine information) will not be
included in the prototype.

To prevent this, do not create prototypes from existing Wabi directories.
Instead, start with no prototype or an existing prototype and re-install the
relevant software.

▼ To Create a Prototype from a Wabi Directory

Follow this procedure to create a prototype from an existing Wabi directory:

1. Choose the Copy WabiDir option.

2. Enter the full path name of the Wabi directory from which you want to
create a prototype.

3. Enter a description.
Enter a description that identifies the planned contents of the new
prototype.

4. Enter the full path name of the location where you want the new
prototype.

5. Choose Apply.
Wabi is started.

6. Exit Wabi.
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7. Choose appropriately to the question, “Are you ready to generate the
prototype?”
If you want to install another application, select No, Restart Wabi. When
Wabi restarts, install another application, using that application’s
installation instructions.

If you do not want to install another application, select Yes.

8. Choose OK to the “Prototype creation complete” message.

The new prototype is immediately added to the entries in the Base Prototype
list box. You can select Inherit Proto and choose this new prototype as the base
from which to create a new prototype.

The new prototype is also displayed in the list of available prototypes when
users access this WabiServer using the rwabi -select  command.

Link Proto

Choose the Link Proto option when you want to make a prototype on another
system available to this server. In this way, you can make the prototype
available to users running Wabi remotely on this system or you can create a
prototype on the current server using the linked prototype as a base.

▼ To Add a Prototype Linked from Another Server

Follow this procedure to link a prototype:

1. Choose the Link Proto option.
The Existing Prototype prompt is highlighted.

2. Enter the full path name of the prototype to which you want to create a
link.
The path you enter must be accessible from your current system.

3. Choose Apply.

4. Choose OK to the “Prototype creation complete” message.

The new prototype is immediately added to the entries in the Base Prototype
list box. You can select Inherit Proto and choose this new prototype as the base
from which to create a new prototype.
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The new prototype will be displayed in the list of available prototypes when
users access this WabiServer using the rwabi -select  command.

If you are creating a link to a prototype that is installed in a shared application
configuration, you must also copy the shared application software to the
current server, as described in the next section.

Using a Linked Prototype with Shared Applications

For system speed with a shared application, you want the shared application to
be on the current WabiServer, rather than on a remote file server or on another
WabiServer. Therefore, when you link a prototype that includes the client
portion of a shared application, you also want to copy the shared portion of the
application to the current WabiServer. In addition, the shared application
should be installed in a specific configuration to make Wabi directory created
form the linked prototype work correctly on the new server. This configuration
was used in Chapter 4, in the sections that created prototypes with Microsoft
Office (page 64) and Lotus SmartSuite (page 69). It is explained in more detail
here.

This is the correct configuration and procedure.

Server A has a prototype called “Microsoft Office” that contains the client
portion of Microsoft Office. It has the following characteristics:

• The shared portion of Microsoft Office is stored in /files1/shared_apps .

• This directory has a link to it from /opt/SUNWwsvr/wsshared.

• The S drive is mapped to /opt/SUNWwsvr/wsshared .

(This is the same setup that was used in the procedure in Chapter 4, page 64.)

You are on Server B and want a prototype with Microsoft Office to be available
to users on Server B. Use the following procedure.

1. Start ws_bldproto .

% ws_bldproto

2. Choose the Link Proto option.
The Existing Prototype prompt is highlighted.

3. Enter the full path name of the existing prototype. Enter
/net/ServerA/files1/shared_apps .
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4. Choose Apply.

5. Choose OK to the “Prototype creation complete” message.
The Microsoft Office prototype is listed in the prototype list box on Server B.
If a user creates a Wabi directory with this prototype now, the Microsoft
Office software will not work. The client portion of Microsoft Office
software is pointing to the /opt/SUNWwsvr/wsshared  directory which
does not exist on Server B. To put the shared portion of Office software on
Server B, continue with Step 6.

6. On Server B, set up a directory that is identical in name to the shared
application directory on Server A. In our example it is the
/files1/wsshared  directory.

# mkdir /net/serverB/files1/shared_apps

7. Enter the commands below to transfer the shared portion of Microsoft
Office software to server B.
Use the tar  command as shown here, rather than the cp  command, to
correctly retain links and permissions.

# cd /net/serverA/files1/sharedapps
# tar cf - . | (cd /files1/shared_apps; tar xfBp -)

8. Create a link from this directory to the directory to which the S drive is
mapped.

# ln -s /files1/shared_apps /opt/SUNWwsvr/wsshared

Note – The shared application directory, the link, and the S drive mapping
must be identical on both systems.

On both Server A and Server B:

/files1/shared_apps ---> /opt/SUNWwsvr/wsshared

S drive is mapped to /opt/SUNWwsvr/wsshared.

Now your new Microsoft Office prototype is ready for users to use on Server B.
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Deleting Prototypes
To delete a prototype, use the rm -r  command. Be sure that you enter the path
correctly. This recursively removes everything in the specified directory. You
can also delete the link from the /opt/SUNWwsvr/protos  directory if you
want to; this is optional.

▼ To Delete a Prototype

1. Enter the following command to delete a prototype.

% rm -r path-of-prototype

2. (Optional) Enter the following command to delete the link to the
prototype, replacing xxxxx with the appropriate characters.

% rm /opt/SUNWwsvr/protos/Protoa xxxxx

Customizing Your Users’ Environment
You can customize the environment for all users of a particular WabiServer by
including a file, /opt/SUNWwsvr/config/local_wabiserver  in the
WabiServer software directory. This file is run each time a user runs Wabi
remotely on this server. You can enter any Bourne shell commands into this
file.

A common use of this file is for Wabi environment variables for international
localization. These are entered in the following format.

VARIABLE=variable_definition
export VARIABLE

See the Wabi User’s Guide (in Answerbook) for information on Wabi
environment variables. Chapter 7, “Wabi International,” contains information
on language, keyboard, and code page variables.

How to Identify a User’s Server and Prototype
There are two files in a user’s home directory that identify the current
WabiServer, Wabi directory, and the prototype that was used to create the Wabi
directory.
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The file ~/.wabiserver  contains the current settings for the variables
WABIDIR and WABISERVER.

In any Wabi directory, the file protoptr.txt  contains the name of the path to
the prototype that created the Wabi directory.
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Troubleshooting 7

This chapter contains solutions to problems you might encounter.

Error message: Insufficient disk space. Message appears during installation.

The SUNWwabi, SUNWwsvr, and, optionally, SUNWwclt for the client, packages
are installed in the /opt  directory by default. If you see a message that the file
system has insufficient disk space, create a symbolic link from /opt  to another
file system with adequate disk space and then enter the pkgadd  command
again. For example, to create a link to the /usr  directory, enter the following
commands as root:

# mkdir /usr/SUNWwabi
# cd /opt
# ln -s /usr/SUNWwabi SUNWwabi

Error message: rwabi: Error: WabiServer “server-name” not accessible - permission problem

A user‘s .rhosts  file is preventing the user from accessing the server. Add the
server name to the .rhosts  file.

./rwabi does not work on a SunOS System

On a SunOS client system, you cannot change your directory to
/opt/SUNWwclt/bin and execute ./rwabi . This does not work. To execute
rwabi , you can enter the entire path name, as follows:

% /opt/SUNWwclt/bin/rwabi
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Or you can include /opt/SUNWwclt/bin  in your path, as described in
Chapter 5, in the section, “Add the SUNWwclt Directory to Your Path” on
page 87 and then enter simply rwabi .

Serial ports (serial printer or a modem) do not work on the server.

Run the following command as superuser:

# chmod 666 /dev/cua/*

When you install the Wabi package, the installation script checks the
permissions of the serial devices. If they are not accessible by all users, the
script suggests that you run the preceding command as superuser: If you do
not do this, you will not be able to use Wabi COM ports for serial devices such
as modems and local serial printers.

Note – With WabiServer software, you cannot use the COM ports on client
systems for serial devices.

Two rwabi sessions
A user cannot run two separate rwabi  sessions on two different servers using
the same Wabi directory.
A user can, however, run two rwabi  sessions on the same server or on
different servers using a different Wabi directory for each session.

Users can’t open Wabi application files from OpenWindows File Manager or Mail Tool

If you create a prototype using the Copy Wabidir option in ws_bldproto ,
binding information (classing engine information) is not included in the
prototype. Users running a Wabi directory from a prototype made in this
manner will be unable to open Wabi application files from within the
OpenWindows File Manager or Mail Tool.

To prevent this, do not create prototypes from existing Wabi directories.
Instead, start with no prototype or an existing prototype and re-install the
relevant software.

If you run ws_bldproto  on a system that is not running OpenWindows,
binding information also might not be included in the Wabi applications.
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Table 7-1 lists the functions of selected WabiServer files and directories.

Table 7-1 WabiServer Files and Directories

File or Directory Function

SUNWwabi Standalone Wabi software

SUNWwabi/bin/wabi Script used to start Wabi

SUNWwabi/bin/wabiclientinstall Commands used to install Wabi on
another machine (without doing a
pkgadd )

SUNWwabi/drvr/clearlocks Command to use in case of
emergency to clear outstanding file
locks

SUNWwabi/lib/locale Localized messages for Wabi

SUNWwabi/lib/vold.switch Used to enable or disable volume
manager’s use of diskette drives.
(CD access still controlled by vold.)

SUNWwabi/man Wabi man pages

SUNWwabi/printers Printer drives for HP Laser Jet and
Epson printers

SUNWwabi/wbin Windows information

SUNWwabi/wbin/sun_ads On-line ads for Sun products

SUNWwabi/wbin/system.ini Windows configuration
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SUNWwsvr WabiServer software

SUNWwsvr/.bin WabiServer commands (not to be
used by end-users)

SUNWwsvr/bin User commands

SUNWwsvr/bin/ws_setup Utility for administering WabiServer

SUNWwsvr/bin/ws_bldproto Tool for building prototypes

SUNWwsvr/bin/rda_server Remote diskette handler

SUNWwsvr/bin/rwabi Script to start WabiServer

SUNWwsvr/bin/rwabi_selproto User tool to select a prototype

SUNWwsvr/bin/rwabi_setup User tool to select a WabiServer and
name a Wabi directory

SUNWwsvr/bin/wabi Script to start Wabi

SUNWwsvr/lib Motif libraries

SUNWwsvr/protos Holds symbolic links to the
prototypes

SUNWwsvr/protos/Protoa0 xxxx Prototype links

SUNWwsvr/config Server configuration directory

SUNWwclt WabiServer client software

SUNWwclt/bin User commands

SUNWwclt/lib Motif libraries

Table 7-1 WabiServer Files and Directories

File or Directory Function
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